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DriveManager 5
DriveManager 5 is a tool for communication between LTi DRiVES servocontrollers and a
PC. Multiple devices can be managed within a project.
This service and diagnostics tool assists commissioning personnel in
–– Commissioning
–– Parameter setting
–– Troubleshooting
–– Analysis of control performance
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Dear user,
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Installation Manual

Installing and starting DM5

We are happy that you have made a decision in favour of a product from LTi DRiVES.
In order to be able to start using your new software quickly and without problems, we
ask you kindly to read this Installation Manual thoroughly beforehand.
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Application Manual
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How do I read the documents?
•• First be sure to read the Installation Manual, so as to install DM5 correctly.
•• With regard to installation, basic configuration and operation of the controller and
motor, refer to the Operation Manual and the Application Manual.
•• If the device is controlled by a variant featuring a field bus, please use the separate
user manuals for the individual bus systems.
•• If using analog outputs and additional encoders, please refer to the relevant specifications.
•• Once wired up, the drive unit can be parameterized with DM5 and commissioned
into operation.
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1. Installation

1.2

Preparing installation

Operating system
Be sure to follow this procedure when installing DM5. Start by checking the minimum
system requirements.

1.1

NOTE: You will need administrator rights for this.
Contact your system administrator if you are in any
doubt.

Minimum system requirements

Operating system

Microsoft Windows XP (SP2) or Windows Vista

Add-on software

Microsoft .NET Framework 2.0

Interface
(Follow the instructions given)

A free Ethernet port
or
A free USB port (not necessary for all devices)

Processor

1.5 GHz

Memory

1 GB RAM

Hard disk

2 GB free hard disk capacity

Drive

CD drive

Monitor

1024 x 768 pixels at 96 dpi recommended

Table 1.1

Make sure your operating system is up-to-date and all Service
Packs (under Windows XP at least Service Pack 2) and updates
have been installed.

Procedure:
•
•
•
•
•

Start
Programs
Internet Explorer
On the “Tools” menu bar
Windows Update

Install all displayed updates as appropriate.

Add-on software

Minimum system requirements

NOTE: You will need administrator rights for this.
Contact your system administrator if you are in any
doubt.

NOTE: The required cables are not supplied with the DM5!
For the Ethernet interface a crosslink Ethernet cable “CC-ECL 0x”, CAT 5 with
2 x RJ45 connectors is required, and for the USB interface (e.g. on ServoOne)
a USB cable “CC-USB 0x”, type A to type B as appropriate.
NOTE: The cable designation is at the same time the order code for purchase
of interface cables.

If the Microsoft .NET Framework 2.0 program is not installed
on your computer, it will be automatically installed before
installing DM5. The installation is carried out in the language in
which DM5 is installed.

Monitor

If your PC meets the minimum system requirements, you can continue preparing the
installation (section 1.2 ).

To provide an adequate quality of display of the user interface,
the monitor resolution should be set to 96 dpi. A higher resolution, such as 120 dpi, will cause segments of text in dialog
boxes to disappear partially or entirely.

DriveManager 5 Installation Manual

[ Installation ]

7

DriveManager 5 Installation Manual

Check the setting and adjust it to 96 dpi as necessary:
•
•
•
•
•
•

Right-click anywhere on the desktop
Properties
“Settings” tab, “Advanced” button
“General” tab, “Display” section
Select “Normal size (96 DPI)”
Click “OK” twice

1.3
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Installing DM5
NOTE: Be sure to observe the instructions set out in the preceding sections
1.1 and 1.2 in order to ensure smooth installation.

DM5 installation procedure:
•• If you received DM5 as a file (e.g. by e-mail or as a download), run “setup.exe”.
•• If you have an installation CD, insert it into your PC’s drive. If the installation does
not start automatically after a few seconds, click on the “setup.exe” file in the
root directory of the CD to start the installation manually.
•• Follow the instructions given by the setup wizard.
Following successful installation, the DM5 and MadCap HelpViewer (Online Help) icons
will be placed on your computer’s desktop. Double-click on the DM5 icon to start the
program. The MadCap HelpViewer is needed to view the Online Help, but does not
need to be started specially.

Figure 1.2 DM5 and MadCap HelpViewer desktop icons

Figure 1.1

Monitor display properties

If your operating system is up-to-date and the monitor is correctly set up, start installing
DM5 (section 1.3 ).

If you want to connect the servocontroller by TCP/IP, continue with section 1.4 “Configuring the TCP/IP network connection” on page 9. If you want to connect the device via
USB (possible on the ServoOne, for example, for user-friendly configuration of the IP address using DM5), first work through section 1.5 “Installing the USB driver” on page 10.

1.4

Configuring the TCP/IP network connection

The easiest way to connect the servocontroller via TCP/IP to a PC, without further configuration on the servocontroller, is to assign the PC’s Ethernet port a static IP address.
Provided the first three octets of the IP address are “192.168.39” (e.g. 192.168.39.155),
DM5 will be able to find the servocontroller.

!

ATTENTION! To use TCP/IP, it is essential that the PC/device network should
not be configured for dynamic IP address assignment by DHCP, but should
use static IP addresses. Otherwise the PC will not be able to find the network devices. If your PC is also connected to a network administered via
DHCP (such as a corporate network with a central data server or printer),
the PC will need an additional network adapter with a static IP address in
order to connect servocontrollers. Contact your network administrator if
you are in any doubt.

If you want to use different IP addresses:
To configure the network adapter, first open the network adapters list box on the PC:
•• Start

The IP address assignment must be in accordance with Class C (192-223). That means:
•• The first three octets of the IP addresses on the PC and the device must be
identical.
•• The fourth octets of the IP addresses on the PC and the device must be different.
•• The fourth octet of the IP address on the first device is by default 5.
Example:
•• PC IP address
Must differ from the device IP address in its last digit.
The device and PC addresses must never be identical.
e.g. PC:		
192.168.39.155
Enter the subnet mask 255.255.255.0.
•• Device IP address
For the controllers in a network:
1st controller:
192.168.39.5.
2nd controller:
192.168.39.6.
3rd controller:
192.168.39.7. etc.

•• Settings

NOTE: The first three octets in the above examples (“192.168.39”) are the
factory default. To be able to find the PC and the devices in your network,
you may need to adapt the first three octets to the IP addresses of your
network.

•• Network connections
NOTE: You will need administrator rights in order to perform the following
steps.

From the open dialog box, select the network adapter you want to use for communication with the servocontroller. Right-click on the relevant adapter and choose:

When you have configured the IP address of the PC network adapter, adapt the IP address of the device according to the above precepts to the conditions of the destination
environment. You can set the device IP address using the two buttons T1 and T2 on the
front of the device. For details on this refer to the servocontroller Operation Manual.

•• Properties

NOTE: On devices with a USB port (e.g. ServoOne), the IP address (parameter
671) can also be configured using DM5 via a USB connection. If you have
configured the IP address in this way, close the current DM5 project and cut
the USB connection.

•• ”General” tab
•• Internet protocol (TCP/IP)
•• ”Properties” button

Then start a new project, as set out in section 2.2 , and in the “Network connections”
dialog box choose “TCP/IP” mode.
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1.5

Installing the USB driver

If the servocontroller has a USB port (as the ServoOne does) and is to be connected by it
to the PC, you need to install a driver before connecting for the first time.

!

• Procedure:
–– In the first dialog box select the bottom option, “No, not this time”, and click
“Next” to confirm.

ATTENTION! The USB port is designed only as a service interface for parameterization of the servocontroller, and not for the function of a higher-level
control.
NOTE: You will need administrator rights in order to perform the following
steps. Contact your system administrator if you are in any doubt. Procedure
for installing the USB driver:

• Connect 24 V control voltage to the device (terminal X9 or X10).
• Interconnect the PC and the device. To do so, connect a USB cable to a free USB
port on the PC and to USB port X2 on the servocontroller (on the front of the
device).
• When the connection has been made, the “Find new hardware wizard” automatically launches on the PC.
Figure 1.3 USB driver installation - Welcome
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–– In the second dialog box select the bottom option, “Install from a list or specific
location (Advanced)”. Click “Next” to confirm.

–– In the third dialog box select the top option, “Browse these sources for the most
suitable driver”, check the “Also browse the following source” checkbox and
specify the subdirectory “drivers” as the path in the DM5 installation directory
(e.g. “C:\Program Files\LTi DRiVES GmbH\LTi DriveManager 5.x.x\drivers”). Click
“Next” to confirm.

Figure 1.4 USB driver installation - Installation method

Figure 1.5 USB driver installation - Source path
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–– Click “Finish” in the last dialog box to complete installation of the USB driver.

1.6

Uninstalling

Procedure under MS Windows XP:
•• Start
•• Settings
•• Control Panel
•• Software
•• Select “LTi Drive Manager 5.x.x”
•• Click “Remove”
DM5 has been removed from your PC.

Figure 1.6 USB driver installation - Finish

Then continue connecting via USB and start a new project (see section 2.2 “Creating a
new project” on page 14).

12

2. Starting DM5
2.1

The empty DM5 user interface appears. For details on the design and function of the
user interface refer to the DM5 Online Help.

User interface

Following successful installation, start DM5 by double-clicking on the DM5 icon on the
desktop.
NOTE: Before starting DM5 and connecting, check the following points:
•• The controller is being supplied with 24 V control voltage (X9 or X10).
•• An Ethernet cable or USB cable is connecting the PC to the controller.
•• For a connection via Ethernet, the IP addresses on the PC and on the device
are matched (as detailed in section 1.4 “Configuring the TCP/IP network
connection” on page 9).
•• For a connection via USB, the USB driver is installed (as detailed in section
1.4 “Configuring the TCP/IP network connection” on page 9).

Figure 2.1 Empty DM5 user interface
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2.2

Creating a new project

To create a new project manually, from the “File” menu choose “New” and then
“Project”.

The first time you run the program a Welcome screen is displayed. On it, you can
choose whether to create a new project or open an existing one. If you do not want
the Welcome screen to be displayed when you launch the program in future, you can
deselect it in the bottom right-hand corner.

Figure 2.2 Welcome screen

Figure 2.3 Creating a new project

14

In the dialog box which opens up, assign a unique name to the project. You can optionally add a brief description of it. You can also specify the path to the project folder. Click
“OK” to confirm all your input.

2.2.1

USB network connection

If you selected “USB” for the network connection, no further configuration is required.
Skip to section 2.2.3 “Completing the network connection” on page 16.

2.2.2

TCP/IP network connection

Another dialog box follows, in which you can choose how you identified the connected
device.

Figure 2.4 “Define project” dialog box

Select the network connection method you want to use and click “OK” to confirm.
Figure 2.6 “Network operation mode” dialog box

!

Figure 2.5 “Network connections” dialog box

ATTENTION! If the Ethernet port is used for communication between DM5
and the device, an installed and enabled software firewall may hinder communications. Make sure the firewall is configured correctly, and also check
your network settings. Contact your network administrator if you are in any
doubt.

•• Connect a single device with well-known IP address
When you choose this option, no automatic identification takes place, but instead,
after confirming with “OK”, you can enter the IP address of the connected device
manually in the dialog box which opens up and again click “OK” to confirm.

DriveManager 5 Installation Manual
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•• Search for devices in all available networks
Select this option if you want to browse all the networks connected to your PC for
devices, without further prompting. Note that this search may take several minutes, depending on the network topology and the number of connected devices!
When a device is found, a connection is automatically made. Then continue with
section 2.2.3 , “Completing the network connection”.

Figure 2.7 “Connect device” dialog box for device IP address

•• Search for devices in one network
If your PC has multiple network adapters, you can use this option to select an
adapter. The network connected to the selected adapter is browsed when you
click “OK” to confirm. You can restrict the range of addresses to browse if you
wish. When a device is found, a connection is automatically made.

Figure 2.9 “Please wait” message box

2.2.3

Completing the network connection

As soon as all necessary settings for the desired connection have been made, the data of
the connected device are read and the connection setup is completed.

Figure 2.10 “Scanning device parameter interface...” message box

You can now configure the connected device by way of the tree structure in the
“Project” window.
•• For details on the tree structure refer to the following section 2.3 , “Information
on the current connection”.
Figure 2.8 “Select network” dialog box

•• For details on configuring the device, refer to the relevant Operation Manual (section 4, Commissioning) or the DM5 Online Help.

2.3

Information on the current connection

•• The network connection method (e.g. USB or TCP/IP) is displayed as the second
level.

In the tree (explorer) structure of the “Project” window you can see the status of the
current connection(s) at any time. The structure is as follows:
•• If the tree structure is displayed in black, communication has been successfully set
up and the device is in Online mode.
Blue type signifies that the device is in Offline mode; parameter changes are not
updated.

Figure 2.13 Second level of tree structure

•• At the third and fourth levels, the individual devices are displayed, with details of
their connections (e.g. port number or IP address) and type (in the screenshot a
ServoOne 400 V device with 6 A rated current).

Figure 2.11 Device in Offline mode (left) or Online mode (right)

•• The first level of the tree structure is the current project.

Figure 2.14 Third and fourth levels of tree structure

Figure 2.12 First level of tree structure
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•• Below the fourth level are the drive settings and the Digital Scope of the individual
devices.

Figure 2.15 Functions and parameters

All further information on DM5 and on configuring your drive is to be found in the DM5
Online Help, which you can access from the menu by choosing ►Menu ►Help ►Contents or by pressing function key “F1” to get context-sensitive help.
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